






Table of Contents


INTRODUCTION



Download the Free Macro Workbook



Version



Comments



GETTING STARTED WITH VBA



What is VBA?



Why do People use VBA?



Common VBA Terms



Adding the Developer Tab to the Ribbon



Visual Basic Editor Overview



How to Insert a Module in the Visual Basic Editor (VBE)



How to Run Macros



WORKSHEET MACROS



Unhide all Worksheets



Hide all Worksheets Except the Active Sheet



Sort Worksheets Alphabetically



Unhide all Rows and Columns



Unmerge all Merged Cells



Auto Fit Columns



Auto Fit Rows



Protect all Worksheets



Unprotect all Worksheets



Insert Multiple Columns



Insert Multiple Rows



Remove Wrap Text



Delete all Worksheets Except the Active Worksheet



WORKBOOK MACROS



Create a Backup of the Current Workbook



Close all Workbooks



Copy Active Worksheet into a New Workbook



Create an Email Message and Attach Active Workbook



Attach Workbook to an Email



HIGHLIGHTING MACROS



Highlight Blank Cells



Highlight Duplicate Values from a Selection



Highlight Alternative Rows in a Selection



Highlight Cells with Misspelled Words



Highlight Specific Text



Highlight Negative Numbers



Highlight Cells with Comments



CHART MACROS



Create a Chart



Format all Charts



Add Chart Title



Paste Chart as an Image



FORMULA MACROS



Remove Spaces from Selected Cells



Convert Date into Day



Convert Date into Year



Remove Time from a Date



Remove Date from Date and Time



Convert Text to Upper Case



Convert Text to Lower Case



Convert Text to Proper Case



Convert Text to Sentence Case



Word Count an Entire Worksheet



Remove an Apostrophe Infront of a Number



Remove Decimals from Numbers



Multiply Numbers by a Specified Amount



Remove Negative Signs from Numbers



Replace Blank Cells with Zeros



Insert A-Z Alphabets in a Range in Upper Case



Insert A-Z Alphabets in a Range in Lower Case



Remove Characters from a String



Insert Degree Symbols



PIVOT TABLE MACROS



Create a New Pivot Table



Delete all Pivot Tables in the Workbook



Delete a Specific Pivot Table



Hide Subtotals in a Pivot Table



Unhide Subtotals in a Pivot Table



Refresh all Pivot Tables in a Workbook



Enable the GETPIVOTDATA Function



Disable the GETPIVOTDATA Function



ADVANCED MACROS



Save a Selected Range as a PDF



Convert Range to an Image



Use Text to Speech



Activate a Data Entry Form



Create a Table of Contents



MORE BOOKS BY EXCEL MASTER CONSULTANT



ABOUT THE AUTHOR



COPYRIGHT © 2021

Copyright Protection

All rights rеsеrvеd. No part оf this publication may bе rеprоducеd, distributed, or transmitted in any form or by any means, including phоtоcоpying, recording, or оthеr еlеctrоnic or mechanical methods, without the prior written permission of the publisher, еxcеpt in the case of brief quotations еmbоdiеd in critical reviews and certain оthеr nоn-cоmmеrcial uses permitted by copyright law.

 


YOUR FREE BONUS GIFT!

[image: ]


As a small token of thanks for buying this book I would like to offer a FREE
 bonus gift to all my readers. I am offering a FREE
 online VBA macros course called How to Record Macros in Excel
 .

In this FREE
 course you will learn:


	How to record a macro to eliminate manual repetitive Excel tasks

	How to execute a macro by:




	Using the Macro Dialog Box




	Using the Visual Basic Editor

	Clicking a button

	Clicking a shape



Once you have completed the course you will be able to:


	Automate Excel tasks easily

	Save valuable time

	Advance your Excel skill
 s



You can register for this FREE
 online VBA course by clicking on the below link and entering your details now.


Register for the free VBA course


 


INTRODUCTION

Macros are arguably the most powerful feature in Excel. They allow you to automate almost every task possible which will save you from doing mundane, repetitive tasks, enable you to become more efficient and ultimately save you time.

This book contains the best and most useful ready-made Macros for you to use in your Excel workbooks. These Macros will enable you to have shortcuts in your workbooks so you don’t have to continually use the Excel ribbon to find the command buttons and perform the tasks manually, saving you hours each day and increasing your productivity. The best thing is, you don’t need VBA knowledge to use these Macros. You can be a complete Excel beginner and still use these Macros in your workbooks. All you need to do is copy these Macros from the free downloadable workbook (link is given in the next section of this chapter) and paste them in your workbook. If you want to learn VBA, you can instead write the VBA codes from this book into your workbooks so you get a feel of writing VBA code yourself. You will learn all about how to enter these Macros in your workbooks and how to run them in the next chapter.

Although this book will give you some background in VBA it is not intended to teach you VBA. If you want to learn VBA you can enrol in my online VBA course for beginners called “Introduction to VBA Macros Course”. For more information about the course just click the link below:


Introduction to VBA Macros Course


Download the Free Macro Workbook

To save you time, you can download the workbook which contains all the Macros in this book. All you need to do is copy the VBA code from the relevant Modules and paste them into the Modules in your workbook. You will learn all about Modules in the next chapter. The link to download the workbook is below
 :


Download the Free Macro Workbook


How this Book is Structured

The Macros in this book are organised under 7 sections:


	Worksheet Macros

	Workbook Macros

	Highlighting Macros

	Chart Macros

	Formula Macros

	Pivot table Macros

	Advanced Macros



You do not need to read this book in order. You can start with the Macros which you will find the most useful first. If you are new to VBA then I would highly recommend that you read the next chapter called “Getting Started with VBA” first as it will give you an introduction to VBA and show you how to insert Modules so you can copy and paste the ready to use Macros in your workbook.

Who is this Book Aimed For?

This book is aimed for people who want:


	To save time and effort as well as increase productivity in Excel

	Powerful shortcuts in their worksheets so they don’t have to continually use the Excel ribbon

	To avoid doing unnecessary, mundane repetitive tasks every day

	To manipulate data in their worksheets quickly and easily without having to use complicated 
 formulas

	To quickly create Excel’s more powerful features such as pivot tables and charts and manipulate them with a click of a button

	To automate their worksheets

	An overview of VBA as they would like to learn VBA coding



Version

I have written the Macros in this book using Excel 2013. These Macros will work in nearly all Excel versions, whether you are using an older Excel version or a newer one.

Comments

I am always interested in receiving feedback from you, either for this book or other books I have written. If you have any specific Excel topics you would like me to write a book about then please let me know. The best way to contact me is through my website:


www.excelmasterconsultant.com


 


GETTING STARTED WITH VBA

This chapter will give you some background about VBA and how to get started. Even though you don’t need to know how to write code to use these ready-made Macros, it is a good idea to know a little about VBA in case you would like to modify the Macros in the future. But first, let’s understand what VBA is.

What is VBA?

VBA stands for Visual Basic for Applications and it is a tool that is used to develop programs that allows Excel to turn complex or time-consuming tasks into automated processes. In simple terms, it is a language that allows you to communicate instructions to Excel using commands. Below are some key features of VBA:


	It is also used in other Microsoft Office programs such as Word, PowerPoint and even Outlook




	It is a standard feature of Microsoft Office products. You do not need to buy a copy




	You write a set of instructions using VBA code when you want Excel to do something




	The main purpose of VBA is to automate common repetitive tasks




	It is developed by Microsoft and was released in 1993




	VBA programming is often called Object Oriented Programming (OOP) because you are working with objects. An object can be Excel itself, a workbook, a worksheet, a chart, a pivot table, a range and so on



Why do People use VBA?

The main reason why people use VBA is to save them time by automating repetitive tasks such as copying and pasting. Below are some other common reasons why people use VBA in the workplace or at home:


	
Format Worksheets Automatically
 – You may need to pull a report from another system such as a database on a daily or weekly basis but the report is not in the desired format. For example, there may be some columns you don’t need or the text is not in the correct font or size. Instead of having to manually delete columns and adjust text font and size each time, you can automate this with a Macro.




	
Create User Forms for Data Entry
 – You can create a user form for data entry so that the data can be entered in a worksheet in a structured format. This is especially useful if there are lots of different people entering data in the same worksheet. You can create drop down boxes so you only enter data from the options given.




	
Create Charts and Pivot Tables Automatically
 – You can write VBA code so that charts and pivot tables are created instantly which therefore saves you valuable time. Once they are created, you can automatically format them too. This book contains Macros that will allow you to do that.




	
Automatically Create Emails and Attach Workbooks to It
 – You may need to send out a daily report at work which is time critical. Instead of having to write the email each time and attach your report to it, you can automate this with a Macro. The Macro can enter the email addresses, the subject, attach the workbook and even write the body of the text and then send the email.




	
Create Advanced Excel Models
 – For the more advanced user, you can create more complex models such as order forms which act like a shopping basket from an internet shopping site for example. You can also create advanced cost models which are not possible to create using just Excel.



Common VBA Terms

In this section I will list some of the common terms used in VBA which you may also see in the 
 VBA codes later in the book.

Comments

You can add comments to your VBA code. This is very useful as you can explain what the blocks of code will do, especially if it is complex and hard to understand. You can also make notes as to why you are doing it. Comments are particularly useful if you need to go back to the VBA code and edit it after a lengthy time away to refresh your memory. Comments are inserted with an apostrophe (‘) at the beginning of the line of text. The line of text will turn green and VBA will just skip this line of code.

Conditions

Conditions work like an IF function in Excel. It evaluates a statement to test whether it is true or false. If the statement is true then it will execute a block of code. If the statement is false then it will execute another set of statements or do nothing at all. The main conditional statements in VBA are If….Then statements and Select Case statements.

Dim

Dim is used to declare a variable to a specific data type. Declaring variables are good practice as it allows your Macro to run more quickly as it uses memory more efficiently.

Loops

Loops allow you to repeat a block of code a specified number of times or until a condition is met. Once the condition is fulfilled then the Macro will execute the next section of the code. There are various types of loops you can perform. The main ones are Do….Until, Do….While and For….Next.

Methods

Methods are actions you perform with an object. A method can change an object’s properties 
 or make the object do something. Examples of Methods are selecting a range of cells, copying a range, pasting a range and clear contents in a range.

Modules

Modules are where Excel stores the VBA code. It is a container to hold all your VBA code. You can have just one Module to store all your VBA code or have multiple Modules to store your code.

Objects

In VBA we work with objects. There are over 250 objects we can work with. Examples of objects include workbooks, worksheets, ranges, cells, charts and pivot tables. Excel itself is an object.

On Error Statements

On Error Statements allow you to perform error handling in your VBA code. The most common error handling statements you will see in VBA code are “On Error GoTo”, “On Error GoTo 0” and “On Error Resume Next”.

Properties

Properties are attributes that describe an object. An object’s property determines how it looks, behaves or whether it is visible or not. Examples of Properties include a cells font, the size of a cell’s font, the colour of a cell or whether the cell is left, centre or right aligned.

Sub Procedure

A Sub procedure contains a list of statements that performs a specific action. Every Macro starts with ‘Sub’ and ends with an ‘End Sub’. A Sub procedure is also known as a Sub routine.

Variables

Variables are values that are stored in the computer’s memory. You can specify a name for a variable and then use the variable in your VBA code.

Adding the Developer Tab to the Ribbon

The Developer tab contains some of the more advanced features of Excel including access to the Visual Basic Editor (VBE) to create your Macros. The Developer tab is used mainly by advanced Excel users and for this reason, Microsoft have hidden this by default. To unhide this tab however is very quick and easy. To get access to the Developer tab follow these instructions:

1) Right click any of the tabs and then from the shortcut menu select Customize the Ribbon


[image: ]


2) In the right-hand box check the Developer
 checkbox and press the OK
 button
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3) The Developer tab is now visible

[image: ]


Visual Basic Editor Overview

The Visual Basic Editor (VBE) is where the Macros are stored. In order for you to write or copy and paste the Macros from this book into your workbook you will need to open the VBE. 
 There are two main ways to do this:


1) 
 Click on the Developer
 tab in your ribbon and under the Code
 group select the Visual Basic
 command button


2) 
 Press the shortcut keys ALT + F11

Below is a brief overview of the VBE.
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Menu Bar

In the menu bar you can customise the VBE such as making the Project Explorer and Properties Window visible. You can also perform various actions such as inserting a Module, saving your VBA code, inserting user forms and run Macros.

Tool Bar

Tool bars allow you quick access to various buttons. You can insert tool bars for editing your code, debugging lines of code and to work with user forms. There is also a standard tool bar which includes the most commonly used buttons such as saving, copy, paste, undo, redo and run Macros.

Project Window

The Project Window displays all the open workbooks and their components such as their worksheets. The Project Window will also display any Excel add-ins.

Properties Window

The Properties Window displays all the properties of the component that is selected in the Project Window. For example, if you select Sheet1 in the Project Window, you can see the name of the worksheet in the Properties Window, whether the page breaks are on or off, whether the sheet is hidden or not and so on. You can also change various settings in the Properties Window.

Code Window

This is where you write your VBA code. If you record a Macro then the VBA code will be stored in here.

How to Insert a Module in the Visual Basic Editor (VBE)

As mentioned earlier in the book, Macros are stored in Modules. You have to manually insert a Module in the VBE so you can write your VBA code in them using the Code Window. You will need to insert a Module in the VBE to copy and paste the ready-made Macros in this book if you have downloaded the free workbook using the link in the Introduction chapter. If you are recording a Macro, then Excel will automatically create a Module for you and store the VBA code in it
 .

To insert a Module, follow these steps:


1) 
 Right click any of the components in the Project Window. In the shortcut menu select Insert
 and then from the next menu select Module
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2) 
 A module is now inserted in the Project Window called Module 1
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Alternatively, you can click on Insert
 from the menu bar and then from the shortcut menu select Module
 .
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If you have downloaded the free workbook which contains all the ready to use Macros from this book you can copy and paste them in a Module in your workbook. You will see there are seven Modules and they are named the same as the chapters in this book. If for example you want to see all the chart Macros you just double click the Module called Chart_Macros
 . 
 You can then just copy the Macros by highlighting them with your mouse and pressing Ctrl + C and then pasting them in a Module in your workbook by pressing Ctrl + V.
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Note
 : In order for a Macro to work, the workbook must be saved in .xlsm format.

How to Run Macros

Once a Macro is in a Module you need to run it. There are four main ways to run Macros:


1) 
 Using the Macro Dialog Box


2) 
 Using the Visual Basic Editor (VBE)


3) 
 Pressing a button or shape


4) 
 Assigning a Macro button to the Quick Access Toolbar (QAT)

Using the Macro Dialog Box

You can run a Macro by using the Macro Dialog Box. To do this follow these steps:


1) 
 In the Excel ribbon go to Developer > Code > Macros to open the Macro Dialog Box


2) 
 Once the Macro Dialog Box is open select a Macro under Macro name
 and then click the Run
 button

[image: ]



Note
 : You can also access the Macro Dialog Box by going to View > Macros > View Macros.

Using the Visual Basic Editor (VBE)

You can also run a Macro through the VBE. To open the VBE you can either go to Developer > Code > Visual Basic from the Excel ribbon or press the shortcuts keys ALT + F11.

There are three different ways to run a Macro from the VBE.

Menu Bar
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Click anywhere in the VBA code and then click on Run
 from the menu bar and then from the shortcut menu select Run Sub/UserForm
 .

Tool Bar
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Click anywhere in the VBA code and then click on the Run Sub/UserForm
 button from the tool bar. This is a green triangle button highlighted in the red box above. If you can’t see this tool bar then click on View
 from the menu bar and then from the menu select Toolbars
 and then Standard
 .

F5 Function Key

The F5 function key is a shortcut for the Run Sub/UserForm
 button. Simply click anywhere in the VBA code and press the F5 key.

Pressing a Button or Shape

You can also run a Macro by pressing a button or a shape in your worksheet. This is my favourite way of running a Macro. First you need to insert a button or shape in your worksheet. Below are the steps to insert a button:


1) 
 From the ribbon click Developer > Controls > Insert > Butto
 n
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2) 
 Click and drag the button anywhere in your worksheet


3) 
 The Assign Macro Dialog Box will appear. Select the Macro you want to assign to the button under Macro name
 and then click on the OK
 button
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You can rename the button from its default ‘Button 1’ name to something more descriptive. Simply right click the button and then from the shortcut menu select Edit Text
 .

To assign a Macro to a shape follow these steps:


1) 
 From the Excel ribbon go to Insert > Illustrations > Shapes and then select a shape


2) 
 Insert the shape into your worksheet


3) 
 Once the shape has been inserted into the worksheet right click it and select Assign Macro
 from the shortcut menu
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4) 
 From the Assign Macro Dialog Box select the Macro you would like to assign to the shape under Macro name
 and then press the OK
 button
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You can name the shape by right clicking it and then from the shortcut menu select Edit Text
 and then type whatever name you like.

Assigning a Macro Button to the Quick Access Toolbar (QAT)

If there is a Macro you use all the time then you can add it to the QAT. Here are the steps to do this:


1) 
 The QAT is located on the top left above the File tab. Click the down arrow which is on the right of the QAT and then from the menu select More Commands
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2) 
 From the Excel Options Dialog Box select Macros
 from the Choose commands from
 drop down box. Select the Macro you would like to add to the QAT from the left-hand box and then click Add
 to insert it to the right-hand box. Then click the OK
 button
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3) 
 The Macro is inserted to the QAT
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Note
 : You can add as many Macros as you like to the QAT using the above steps.


WORKSHEET MACROS

In this chapter you will find all the best and most useful Macros to use in your worksheets. All the Macros in this chapter allow you to manipulate columns, rows, cells and worksheet tabs with just a single click of a button. To use these Macros as shortcuts, I recommend that you create a button in the worksheet or add them to your Quick Access Toolbar as explained in the previous chapter of the book.

Unhide all Worksheets

What Does this Macro Do?

This Macro will unhide all hidden worksheets in one go. This is especially useful if you have a workbook which contains many hidden worksheets. To unhide the worksheets individually one by one can take a long time but with this Macro it can be done instantly. This Macro contains a loop which goes through each worksheet in the active workbook. If the worksheet is not visible then it will unhide it.

Source VBA Code

Sub UnhideWorksheets()

'This code will unhide all worksheets in the workbook

Dim ws As Worksheet

For Each ws In ActiveWorkbook.Worksheets

ws.Visible = xlSheetVisible

Next ws

End Sub


Hide all Worksheets Except the Active Sheet

What Does this Macro Do?

This Macro hides all the worksheets except the active worksheet. This is especially useful if you have a workbook that has a worksheet which contains a summary report or dashboard and you have lots of other worksheets which contains calculations, pivot tables or VLOOKUP tables that you want to hide. For this Macro to work, just select the worksheet you want to keep unhidden and then run the Macro. It will then hide all the other worksheets except the active one.

Source VBA Code

Sub HideAllWorksheetsExceptActiveSheet()

'This code will hide all the worksheets except the active worksheet

Dim ws As Worksheet

For Each ws In ThisWorkbook.Worksheets

If ws.Name <> ActiveSheet.Name Then ws.Visible = xlSheetHidden

Next ws

End Sub

 


Sort Worksheets Alphabetically

What Does this Macro Do?

This Macro will sort your worksheet tabs in alphabetical order. This is useful if your worksheet tabs are named after people or products and you want to put them in order to make your workbook more organised.

Source VBA Code

Sub SortSheetNames()

'This code will sort the worksheet tabs in alphabetical order

Application.ScreenUpdating = False

Dim SheetCount As Integer, i As Integer, j As Integer

SheetCount = Sheets.Count

For i = 1 To SheetCount - 1

For j = i + 1 To SheetCount

If Sheets(j).Name < Sheets(i).Name Then

Sheets(j).Move before:=Sheets(i)

End If

Next j

Next i

Application.ScreenUpdating = True

End Sub

 


Unhide all Rows and Columns

What Does this Macro Do?

This Macro will unhide all rows and columns. This is particularly useful if you have received a workbook from somebody and you want to ensure all rows and columns are not hidden.

Source VBA Code

Sub UnhideRowsColumns()

'This code will unhide all rows and columns in the Worksheet

Columns.EntireColumn.Hidden = False

Rows.EntireRow.Hidden = False

End Sub

 


Unmerge all Merged Cells

What Does this Macro Do?

This Macro will unmerge any cells that are merged. People often merge cells to format their worksheets to make it more presentable, especially if they need to print them. The problem with merging cells is that you can’t sort the data. Merged cells can also cause errors in Macros when they are trying to manipulate them. This Macro will select all the cells in the active worksheet and if any cells are merged it will unmerge them.

Source VBA Code

Sub UnmergeAllCells()

'This code will unmerge all the merged cells

ActiveSheet.Cells.UnMerge

End Sub

 


Auto Fit Columns

What Does this Macro Do?

This Macro will auto fit all the columns in the worksheet. It will select all the cells and auto fit the columns which have text, dates or numbers in them. This ensures that all text is visible and readable in your worksheet.

Source VBA Code

Sub AutoFitColumns()

'This code will auto fit all columns

Cells.Select

Cells.EntireColumn.AutoFit

End Sub

 


Auto Fit Rows

What Does this Macro Do?

This Macro will auto fit all the rows in the worksheet. It works in the same way as the previous one which auto fits the columns. It will select all the cells and auto fit the rows which have text, dates or numbers in them.

Source VBA Code

Sub AutoFitRows()

'This code will auto fit all rows

Cells.Select

Cells.EntireRow.AutoFit

End Sub

 


Protect all Worksheets

What Does this Macro Do?

This Macro will protect all the worksheets in one go. An input box will appear where it will ask you to enter a password. Be careful with the Caps Lock as the password is case sensitive. This Macro contains a loop and goes through each worksheet in the active workbook and password protects them.

Source VBA Code

Sub ProtectWorksheets()

'This code will protect all worksheets in the workbook

Dim ws As Worksheet

Dim password As String

password = InputBox("Enter a Password.", vbOKCancel)

For Each ws In ActiveWorkbook.Worksheets

ws.Protect password:=password

Next ws

End Sub


Unprotect all Worksheets

What Does this Macro Do?

This Macro will unprotect all the worksheets in your workbook. You need to enter the password you used to protect your worksheets in the line of code where it says password = “password” as mentioned in the comment below for this Macro to work. This Macro contains a loop and goes through each worksheet in the active workbook and unprotects them.

Source VBA Code

Sub UnprotectWorkSheets()

'This code will unprotect all the worksheets in the workbook

Dim ws As Worksheet

Dim password As String

password = "password" 'replace “password” with the password you used to protect your worksheets


For Each ws In Worksheets

ws.Unprotect password:=password

Next ws

End Sub      




Insert Multiple Columns

What Does this Macro Do?

This Macro will insert multiple columns in your worksheet in one go. This is much quicker than inserting columns manually one at a time. You first need to select a cell in your worksheet where you want to insert the new columns. When you run the Macro an input box will appear asking you to specify how many columns you want to insert. It will then insert the specified number of new columns after the selected cell.

Source VBA Code

Sub InsertMultipleColumns()

'This code will insert multiple columns in the worksheet in one go. You first need to select a cell in your worksheet where you want to insert the new columns

Dim i As Integer

Dim j As Integer

ActiveCell.EntireColumn.Select

On Error GoTo Last

i = InputBox("Enter number of columns to insert", "Insert Columns")

For j = 1 To i

Selection.Insert Shift:=xlToRight, CopyOrigin:=xlFormatFromRightorAbove

Next j

Last: Exit Sub

End Sub



 


Insert Multiple Rows

What Does this Macro Do?

This Macro works in the same way as the Insert Multiple Columns Macro. You first need to select a cell in the worksheet where you want the new rows to appear. Once you specify the number of rows you want to insert from the input box, the Macro will insert the specified number of rows below the active cell.

Source VBA Code

Sub InsertMultipleRows()

'This code will insert multiple rows in the worksheet in one go. You first need to select a cell in your worksheet where you want to insert the new rows

Dim i As Integer

Dim j As Integer

ActiveCell.EntireRow.Select

On Error GoTo Last

i = InputBox("Enter number of columns to insert", "Insert Columns")

For j = 1 To i

Selection.Insert Shift:=xlToDown, CopyOrigin:=xlFormatFromRightorAbove

Next 
 j

Last: Exit Sub

End Sub

 


Remove Wrap Text

What Does this Macro Do?

This Macro will remove wrap text from all the cells in the entire worksheet with just one click. You may need to remove wrap text if you paste information from a web page for example and the columns are not wide enough to display the text. You can use this Macro to remove wrap text and then use the auto fit columns Macro to ensure all text is visible.

Source VBA Code

Sub RemoveWrapText()

'This code removes wrap text from all cells in the worksheet

Cells.WrapText = False

End Sub

 


Delete all Worksheets Except the Active Worksheet

What Does this Macro Do?

This Macro will delete all the worksheets in the workbook except for the active worksheet. This Macro contains a loop which compares the active worksheet name with the names of the other worksheets. If the worksheet name doesn’t equal the active worksheet name it will delete the worksheet.

Source VBA Code

Sub DeleteWorksheetsExceptActive()

'This code will delete all the worksheets in one go except for the active worksheet

Dim ws As Worksheet

For Each ws In ThisWorkbook.Worksheets

If ws.Name <> ThisWorkbook.ActiveSheet.Name Then

Application.DisplayAlerts = False

ws.Delete

Application.DisplayAlerts = True

End If

Next ws

End Sub


WORKBOOK MACROS

All the Macros in this chapter will allow you to work with workbooks quickly and easily.

Create a Backup of the Current Workbook

What Does this Macro Do?

This Macro will save a backup of your current workbook. It will save the backup in the same directory as where your current workbook is located and will also insert the date the Macro was run and the file name.

Source VBA Code

Sub WorkbookBackUp()

'This code will save a backup of your current workbook and save it in the same location. It will insert a file name and the date the Macro was run

ThisWorkbook.SaveCopyAs Filename:=ThisWorkbook.Path & _

"" & Format(Date, "mm-dd-yy") & " " & _

ThisWorkbook.Name

End Sub


Close all Workbooks

What Does this Macro Do?

This Macro will close all open workbooks in one go except the workbook which contains this Macro. It uses a loop to check if the workbook name is equal to the workbook name which contains the Macro. If the workbook name is not equal to the workbook name which contains the Macro then it will close it.

Source VBA Code

Sub CloseOtherWorkbook()

'This code closes all workbooks except the workbook with the Macro in

Dim WB As Workbook

Application.ScreenUpdating = False

For Each WB In Application.workbooks

If WB.Name <> ThisWorkbook.Name Then

WB.Close

End If

Next

Application.ScreenUpdating = True

End Sub


Copy Active Worksheet into a New Workbook

What Does this Macro Do?

This Macro will copy the active worksheet into a blank new workbook. This is useful if you have a workbook which contains a dashboard or a report in a single worksheet but also contains many other worksheets. Maybe you want to send just the worksheet that contains the dashboard or report to a customer or colleague without having to hide the other unwanted worksheets. This Macro is perfect for that as it will copy just the worksheet with the dashboard or report into a blank new workbook which you can then send. This also reduces the file size as the workbook only contains one worksheet.  To run the Macro, simply select the worksheet you want to copy to the new workbook and then run the Macro.

Source VBA Code

Sub CopyWorksheetToNewWorkbook()

'This code will copy the active sheet into a new workbook

ThisWorkbook.ActiveSheet.Copy Before:=workbooks.Add.Worksheets(1)

End Sub


Create an Email Message and Attach Active Workbook

What Does this Macro Do?

This Macro will open a blank new email, attach the active workbook to it, insert the email address or addresses and the subject header as well as write the text in the body of the email. To modify the code to your requirements simply amend the .to
 , .subject
 and the .body
 lines of code as indicated in the comments below. To directly send the email instead of displaying it change the line of code where it says .display
 to .send
 .

Source VBA Code

Sub SendMailWithAttachment()

'This code will attach the active workbook to an email, insert the email address, subject header and write the body of the text

Dim OutApp As Object

Dim OutMail As Object

Set OutApp = CreateObject("Outlook.Application")

Set OutMail = OutApp.CreateItem(0)

With OutMail

.to = "Sales.Manager@company.com" 'Insert the email address or addresses you want to send the attachment to here


.Subject = "Sales Report" 'Insert the subject you would like to use here


.Body = "Hi Sales Manager, Please find attached the Sales Report." 'Write the body of the text here


.Attachments.Add ActiveWorkbook.FullName

.display 'If you want to send the email instead of displaying it use .send instead of .display


End With

Set OutMail = Nothing

Set OutApp = Nothing

End Sub


Attach Workbook to an Email

What Does this Macro Do?

This Macro will open a new email and attach the active workbook to it.

Source VBA Code

Sub AddWorkbookToEmail()

'This code will open up a new email and attach the current workbook

Application.Dialogs(xlDialogSendMail).Show

End Sub


HIGHLIGHTING MACROS

All the Macros in this chapter highlights specific cells or ranges. These Macros will help you with data integrity and make your worksheets easier to read and stand out as well as to emphasise certain values.

Highlight Blank Cells

What Does this Macro Do?

This Macro will highlight any cells that are blank. It will open an input box which will ask you to specify a range in the worksheet. You simply select the range of cells in the worksheet and then it will highlight any cells in the specified range which are blank in red.

Source VBA Code

Sub HighlightBlankCells()

'This code will highlight all the blank cells in red in the dataset

Dim DateRange As Range

Set DateRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

DateRange.SpecialCells(xlCellTypeBlanks).Interior.Color = vbRed

End Sub


Highlight Duplicate Values from a Selection

What Does this Macro Do?

This Macro will highlight any duplicate values from the selected range. An input box will appear asking you to select a range of values. It will then highlight any duplicate values in red. This Macro is very good for data integrity. Maybe you have imported a set of data from another program such as a database and it contains duplicate values. With this Macro you can highlight the duplicates very quickly and then delete them so your dataset contains just unique values.

Source VBA Code

Sub HighlightDuplicates()

'This code will highlight duplicate values from a specified range

Dim DataRange As Range

Dim Cell As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

If WorksheetFunction.CountIf(DataRange, Cell.Value) > 1 Then

Cell.Interior.ColorIndex = 3

End I
 f

Next Cell

End Sub

 


Highlight Alternative Rows in a Selection

What Does this Macro Do?

This Macro highlights alternative rows green in the selection. Highlighting rows can make your data easier to read, especially if you need to print it out and go through the data. When the Macro is run, an input box will appear asking you to specify the range. Once you have selected a range it will highlight alternative rows in green. You can change the colour if you wish. Just change vbGreen to vbBlue, vbRed, vbCyan and so on depending on what colour you would like as mentioned in the comment below. 

Source VBA Code

Sub HighlightAlternateRows()

'This code highlights alternate rows in the selection

Dim DataRange As Range

Dim MyRow As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each MyRow In DataRange.Rows

If MyRow.Row Mod 2 = 1 Then

MyRow.Interior.Color = vbGreen 'This highlights alternative rows in green. You can highlight the rows in different colours such as vbRed, vbCyan, vbBlue


End If

Next MyRo
 w

End Sub


Highlight Cells with Misspelled Words

What Does this Macro Do?

This Macro will highlight any cells that contain misspelled words in the worksheet. It will check each cell and highlight the cells red if it contains a misspelled word. This is very useful as Excel doesn’t have a spell check in the Excel ribbon like with Microsoft Word or PowerPoint. You can run a spell check in Excel by pressing the F7 key but you have to run through each misspelled word one at a time and it doesn’t highlight the cells that contain the misspelled word like it does with this Macro.

Source VBA Code

Sub HighlightMisspelledCells()

'This code will highlight cells that have misspelled words

Dim cell As Range

For Each cell In ActiveSheet.UsedRange

If Not Application.CheckSpelling(word:=cell.Text) Then

cell.Interior.Color = vbRed

End If

Next cell

End Sub


Highlight Specific Text

What Does this Macro Do?

This Macro will count and highlight specific text in the worksheet. An input box will appear asking you to enter the text you want to check. Once you press the ok button a message box will appear specifying how many there are in the worksheet and then it will highlight them in yellow.

Source VBA Code

Sub HighlightSpecificText()

'This code will highlight and count text you specify

Dim rng As Range

Dim i As Integer

Dim val As Variant

val = InputBox("Enter Text To Highlight")

For Each rng In ActiveSheet.UsedRange

If rng = val Then

rng.Style = "Note"

i = i + 1

End If

Next rn
 g

MsgBox "There are total " & i & " " & val & " in this worksheet."

End Sub


Highlight Negative Numbers

What Does this Macro Do?

This Macro will highlight values that are negative from a specified selection. This is very useful if you want to highlight under performance in a dashboard (if scores under 0 mean poor performance). When you run this Macro an input box will appear asking you to select the range of values in the worksheet. Once you click the ok button it will highlight the negative values in red.

Source VBA Code

Sub HighlightNegativeNumbers()

'This code will highlight negative values in red in a specified selection

Dim Rng As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Rng In DataRange

If WorksheetFunction.IsNumber(Rng) Then

If Rng.Value < 0 Then

Rng.Font.Color = -16776961

End If

End If

Next

End Sub


Highlight Cells with Comments

What Does this Macro Do?

This Macro will highlight any cells in red which contains a comment. Normally, when a cell contains a comment it has a small red triangle in the top right-hand corner. This can be difficult to see but with this Macro the whole cell turns red which makes it much easier to determine which cells contains comments. You can make the cells turn another colour other than red if you wish. Just change the line of code from vbRed to vbGreen, vbBlue, vbCyan and so on depending on what colour you would like as mentioned in the comment below.

Source VBA Code

Sub HighlightCellsWithComments()

'This code will highlight cells that have comments

ActiveSheet.Cells.SpecialCells(xlCellTypeComments).Interior.Color = vbRed 'You can highlight the cells in a different colour such as vbGreen, vbCyan, vbBlue and so on


End Sub

 


CHART MACROS

The Macros in this section will help you to create and manipulate charts quickly and easily. No more having to go through various buttons in the Excel ribbon to create and format charts which means you will save time and effort.

Create a Chart

What Does this Macro Do?

This Macro will create a 2D column chart with just a single click. It will ask you to specify the range where your data is and then it will create the 2D column chart instantly.

Source VBA Code

Sub CreateChart()

'This code will create a 2D column chart

Dim MyChart As Chart

Dim DataRange As Range

Set MyChart = ActiveSheet.Shapes.AddChart.Chart

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

MyChart.SetSourceData Source:=DataRang
 e

MyChart.HasTitle = True

End Sub



 


Format all Charts

What Does this Macro Do?

This Macro will format all your charts in your worksheet with a single click. First, it will change the chart to a 3D Clustered Column chart. It will then apply a layout and chart style, remove the legend, and set minimum and maximum axis values. You can change the code to apply different formatting and styles. See the comments in green in the code below. This is a very quick and easy way to format all your charts in one go.

Source VBA Code

Sub FormatAllCharts()

'This code will format all your charts in the worksheet in one go

Dim ChrtObj As ChartObject

For Each ChrtObj In ActiveSheet.ChartObjects

With ChrtObj.Chart

.ChartType = xl3DColumnClustered 'You can change the chart type here


.ApplyLayout 3 'You can change the chart layout here. Choose between 1 and 10


.ChartStyle = 12 'You can change the chart style here. Choose between 1 and 48


.ClearToMatchStyle

.SetElement msoElementChartTitleAboveChart

.SetElement msoElementLegendNone

.SetElement msoElementPrimaryValueAxisTitleNon
 e

.SetElement msoElementPrimaryCategoryAxisTitleNone

.Axes(xlValue).MinimumScale = 0 'You can change the minimum scale here


.Axes(xlValue).MaximumScale = 1000 'You can change the maximum scale here


End With

Next ChrtObj

End Sub


Add Chart Title

What Does this Macro Do?

This Macro will add a chart title if it doesn’t have one and then it will name it. When the Macro is run, an input box will appear asking you to enter the desired name of the chart. Once you press the ok button, the chart title will be inserted.

Source VBA Code

Sub InsertChartTitle()

'This code will ask you to enter the name of the chart and then insert the chart title

Dim i As Variant

i = InputBox("Please enter your chart title", "Chart Title")

On Error GoTo Last

ActiveChart.SetElement (msoElementChartTitleAboveChart)

ActiveChart.ChartTitle.Text = i

Last: Exit Sub

End Sub

 


Paste Chart as an Image

What Does this Macro Do?

This Macro will convert a chart to an image. This is really useful if you want to format the chart using the various formatting options in Picture Tools from the ribbon. You can use these chart images in summary dashboards and apply special formatting to make them really stand out rather than using the conventional chart formatting options. You need to ensure a chart is selected first before you run this Macro. If a chart is not selected then a message box will appear asking you to select the chart first.

Source VBA Code

Sub ConvertChartToImage()

'This code will convert a chart to an image

On Error Resume Next

ActiveChart.ChartArea.Copy

If Err.Number = 91 Then

MsgBox ("Please select a chart first")

Exit Sub

End If

ActiveSheet.Range("A1").Select

ActiveSheet.Pictures.Paste.Selec
 t

End Sub

 


FORMULA MACROS

The Macros in this section work like formulas but without you having to write the formulas in the worksheet. These Macros will either perform calculations or return results. The big advantage of these Macros is that you don’t need to write complex formulas to manipulate the data which therefore saves you time and effort.

Remove Spaces from Selected Cells

What Does this Macro Do?

This Macro will remove extra spaces from the beginning and end of a text string in a cell. An input box will appear asking you to select the range where your text strings are and then remove the unwanted spaces from the cells in the selected range.

Source VBA Code

Sub RemoveExtraSpaces()

'This code will remove spaces from the beginning and end of text

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

If Not IsEmpty(Cell) Then

Cell = Trim(Cell)

End If

Next Cell

End Sub


Convert Date into Day

What Does this Macro Do?

This Macro will convert dates in a worksheet to just the day. This is really useful if you have a set of dates in your worksheet but you just need to show the days rather than the whole date. If you tried to extract just the day from a date using a formula with the LEFT function you will not get the result you are after. It will extract the specified numbers from the left of the date serial number instead. The Macro will ask you to select the range of dates in the worksheet using an input box and then it will extract just the day.

Source VBA Code

Sub ConvertDateToDay()

'This code will convert the date to a day

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

If IsDate(Cell) = True Then

With Cell

.Value = Day(Cell)

.NumberFormat = "0
 "

End With

End If

Next Cell

End Sub


Convert Date into Year

What Does this Macro Do?

This Macro works in the same way as the previous one which converts a date into a day. Instead of converting the dates into a day, it converts them into a year.

Source VBA Code

Sub ConvertDateToYear()

'This code will convert the date to a year

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

If IsDate(Cell) = True Then

With Cell

.Value = Year(Cell)

.NumberFormat = "0"

End With

End If

Next Cel
 l

End Sub


Remove Time from a Date

What Does this Macro Do?

This Macro removes the time from a date. If you have a set of dates with the times, you can remove the times with this Macro. You often get times in a date when you extract data from a database such as SQL. The times are more often than not unwanted. Removing the times can be achieved with a complicated worksheet formula but with this Macro you can achieve this very quickly and easily. When the Macro is run, simply select the range of dates in the worksheet using the input box and away you go.

Source VBA Code

Sub RemoveTimeFromDates()

'This code will remove the date from cells which contains the date and time

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

If IsDate(Cell) = True Then

Cell.Value = VBA.Int(Cell.Value)

End If

Nex
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DataRange.NumberFormat = "dd-mmm-yy"

End Sub


Remove Date from Date and Time

What Does this Macro Do?

This Macro works in the exact same way as the previous Macro which removes the time from a date. This Macro does the opposite however as it removes the date from the cells which contains the date and time.

Source VBA Code

Sub removeDateFromDateTime()

'This code will remove the date from cells which contains the date and time

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

If IsDate(Cell) = True Then

Cell.Value = Cell.Value - VBA.Fix(Cell.Value)

End If

Next

DataRange.NumberFormat = "hh:mm:ss am/pm
 "

End Sub


Convert Text to Upper Case

What Does this Macro Do?

This Macro converts all the characters in text to upper case. Even though there is an Excel Function called UPPER that converts text to upper case you have to use another column to enter the formula. With this Macro, an input box will appear asking you to select the range of cells that contains the text which you want to convert to upper case. Once you press the ok button all the characters in the text will change to upper case in the same cells. No need to use helper columns which will save spreadsheet space.

Source VBA Code

Sub ChangeToUpperCase()

'This code will change all the characters in text to upper case

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

If Cell.HasFormula = False Then

Cell.Value = UCase(Cell.Value)

End If

Next Cel
 l

End Sub


Convert Text to Lower Case

What Does this Macro Do?

This Macro does exactly the same as the previous Macro which converts all characters in a text to upper case but this one converts it to lower case.

Source VBA Code

Sub ChangeToLowerCase()

'This code will change all the characters in text to lower case

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

If Cell.HasFormula = False Then

Cell.Value = LCase(Cell.Value)

End If

Next Cell

End Sub


Convert Text to Proper Case

What Does this Macro Do?

This Macro works in the same way as the previous two Macros which converts text to upper and lower case. This Macro however converts text to proper case. This means the first character will be upper case and the rest in lower case for each word. 

Source VBA Code

Sub ChangeToProperCase()

'This code will change the text to proper case

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

If WorksheetFunction.IsText(Cell) Then

Cell.Value = WorksheetFunction.Proper(Cell.Value)

End If

Next

End Sub


Convert Text to Sentence Case

What Does this Macro Do?

This Macro works in the same way as the previous three Macros which converts text to upper, lower and proper case. This Macro however converts text to sentence case. This means the first character in the sentence will be in upper case and the rest will be in lower case. You may be wondering what the difference is between proper case and sentence case. Proper case changes the first character of every word in upper case and the rest to lower case like this “This Is Proper Case”. Sentence case changes just the first character in a sentence to upper case and the rest to lower case like this “This is sentence case”.

Source VBA Code

Sub ChangeToSentenceCase()

'This code will change the text to sentence case

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

If WorksheetFunction.IsText(Cell) Then

Cell.Value = UCase(Left(Cell, 1)) & LCase(Right(Cell, Len(Cell) - 1))

End If

Next Cel
 l

End Sub


Word Count an Entire Worksheet

What Does this Macro Do?

This Macro will count all the words in the entire worksheet. Unlike Microsoft Word, there is no word count in Excel. You may want to write a document in Excel rather than Word but be limited in the number of words you need to write in the document. With this Macro you can keep track of how many words you have written.

Source VBA Code

Sub CountWordsInWorksheet()

'This code will count all the words in the worksheet

Dim WordCnt As Long

Dim Cell As Range

Dim S As String

Dim N As Long

For Each Cell In ActiveSheet.UsedRange.Cells

S = Application.WorksheetFunction.Trim(Cell.Text)

N = 0

If S <> vbNullString Then

N = Len(S) - Len(Replace(S, " ", "")) + 1

End If

WordCnt = WordCnt + N

Next Cell

MsgBox "There are total " & Format(WordCnt, "#,##0") & " words in the active worksheet"

End Sub


Remove an Apostrophe Infront of a Number

What Does this Macro Do?

This Macro will remove apostrophes (‘) in front of numbers. When there is an apostrophe in front of a number, it converts the number to a text. This means you can’t perform calculations with them. You often get data, especially when it is pulled from a database that has apostrophes in front of numbers. You would have to use the VALUE worksheet function to convert these to numbers which means using an extra column to write the formula. You could also click in the cell where an exclamation mark (!) will appear. You can then click the exclamation mark and then select ‘Convert to Number’ to convert the text numbers to actual numbers. Both these methods just take longer than it needs to. With this Macro, just run it, select the range from the input box and it instantly removes the apostrophes and converts the text to numbers.

Source VBA Code

Sub RemoveApostrophesFromNumbers()

'This code will remove apostrophes from numbers

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

DataRange.Value = DataRange.Value

End Sub


Remove Decimals from Numbers

What Does this Macro Do?

This Macro will remove the decimals from numbers and leave just the numbers before the decimal. People often remove the decimals from numbers to make their worksheets or reports look cleaner and easier to read.

Source VBA Code

Sub RemoveDecimals()

'This code will remove decimals from numbers

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

Cell.Value = Int(Cell)

Cell.NumberFormat = "0"

Next Cell

End Sub


Multiply Numbers by a Specified Amount

What Does this Macro Do?

This Macro will multiply the selected cells by a specified number. First an input box will appear asking you to select the range of cells you want to multiply. A second input box will appear asking you to enter the number you want to multiply by. It will then multiply the selected range by the specified number. To change the calculation simply change (*) to (+) for addition, (-) for subtraction or (/) for division as mentioned below.

Source VBA Code

Sub MultiplyNumbers()

'This code will multiply the selected numbers in the worksheet by a specified number

Dim Cell As Range

Dim i As Integer

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

i = InputBox("Enter number to multiple", "Input Required")

For Each Cell In DataRange

If WorksheetFunction.IsNumber(Cell) The
 n

Cell.Value = Cell * i ' To change the calculation simply change * to -, +, or /


Else

End If

Next Cell

End Sub


Remove Negative Signs from Numbers

What Does this Macro Do?

This Macro will remove the negative signs from numbers. You may want to do this because you want to convert the numbers from negative to positive. When the Macro is run, an input box will appear asking you to select the range of numbers in the worksheet. When you click the ok button, the Macro will go through each cell and check which numbers have negative signs and then remove them.

Source VBA Code

Sub RemoveNegativeSign()

'This code will remove the negative signs from numbers

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

DataRange.Value = DataRange.Value

For Each Cell In DataRange

If WorksheetFunction.IsNumber(Cell) Then

Cell.Value = Abs(Cell)

End If

Next Cel
 l

End Sub


Replace Blank Cells with Zeros

What Does this Macro Do?

This Macro will replace any blank cells with zeros in a selected range. This can make your worksheet look cleaner and you can perform calculations much easier with cells that contains zeros than if they were blank. When you run the Macro, an input box will appear asking you to select a range. When you press the ok button, the Macro will go through each selected cell and insert zeros to the cells which are blank.

Source VBA Code

Sub ReplaceBlankCellsWithZeros()

'This code will replace any blank cells with zeros in a selected range

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

DataRange.Value = DataRange.Value

For Each Cell In DataRange

If Cell = "" Or Cell = " " Then

Cell.Value = "0"

Els
 e

End If

Next Cell

End Sub


Insert A-Z Alphabets in a Range in Upper Case

What Does this Macro Do?

This Macro will insert all the letters of the alphabets in upper case. Just select the cell where you want the first letter to appear and then run the Macro. The letters of the alphabet will appear in each row from A to Z in upper case.

Source VBA Code

Sub InsertUpperCaseAlphabets()

'This code will insert all the letters of the alphabet in upper case

Dim i As Integer

For i = 65 To 90

ActiveCell.Value = Chr(i)

ActiveCell.Offset(1, 0).Select

Next i

End Sub


Insert A-Z Alphabets in a Range in Lower Case

What Does this Macro Do?

This Macro works in exactly the same way as the previous one but enters all the letters of the alphabet in lower case.

Source VBA Code

Sub InsertLowerCaseAlphabets()

'This code will insert all the letters of the alphabet in lower case

Dim i As Integer

For i = 97 To 122

ActiveCell.Value = Chr(i)

ActiveCell.Offset(1, 0).Select

Next i

End Sub


Remove Characters from a String

What Does this Macro Do?

This Macro will remove specified characters from a text string. When the Macro is run an input box will appear asking you to select the range of text in the worksheet. A second input box will appear asking you what characters you want to remove. The Macro will then go through each cell in the selected range and if the characters you want removed appear, it will remove them from the text string.

Source VBA Code

Sub RemoveCharacters()

'This code will remove specified characters from a text string from the selected range

Dim Cell As Range

Dim Char As String

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

Char = InputBox("Character(s) to Replace", "Enter Value")

For Each Cell In DataRange

DataRange.Replace What:=Char, Replacement:=""

Nex
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End Sub


Insert Degree Symbols

What Does this Macro Do?

This Macro will insert a degree symbol after each number in the selected range. When the Macro is run, an input box will appear asking you to select a range. The Macro will go through each cell in the selected range and insert a degree symbol after the number.

Source VBA Code

Sub InsertDegreeSymbol()

'This code will insert a degree symbol after each number in the selected range

Dim Cell As Range

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

For Each Cell In DataRange

Cell.Select

If ActiveCell <> "" Then

If IsNumeric(ActiveCell.Value) Then

ActiveCell.Value = ActiveCell.Value & "°"

End If

End If

Next

End Sub


PIVOT TABLE MACROS

The Macros in this section will help you to create, delete, manipulate and amend pivot tables quickly and easily. If you are new to pivot tables or would like to learn more about them you can read my comprehensive book about pivot tables for beginners which I have written. For more information about the book, click either of the links below:

Amazon UK:


Excel Bible for Beginners: The Step by Step Guide to Create Pivot Tables to Perform Excel Data Analysis and Data Crunching


Amazon US:


Excel Bible for Beginners: The Step by Step Guide to Create Pivot Tables to Perform Excel Data Analysis and Data Crunching


Create a New Pivot Table

What Does this Macro Do?

This Macro will create a blank pivot table in a new worksheet with just a single click. You first have to activate the worksheet where the source data is and then run the Macro. The source data will need to start in cell A1. Once you run the Macro it will select all the source data in the worksheet. Even if you add more rows or columns to the source data later and you run the Macro again it will use the new data. The Macro will then insert a new worksheet and insert a blank pivot table in the new worksheet.

Source VBA Code

Sub CreateNewPivotTable(
 )

'This code will create a new pivot table in a new worksheet from the data in the active worksheet

Dim Sht As Worksheet

Dim ptCache As PivotCache

Dim pt As PivotTable

Dim StartPt As String

Dim SourceData As String

'Specifies the data range from the active worksheet

SourceData = ActiveSheet.Name & "!" & Range("A1").CurrentRegion.Address(ReferenceStyle:=xlR1C1)

'Inserts a new worksheet

Set Sht = Sheets.Add

'The pivot table will start in cell A2

StartPt = Sht.Name & "!" & Sht.Range("A2").Address(ReferenceStyle:=xlR1C1)

'Create a Pivot Cache from the source data

Set ptCache = ActiveWorkbook.PivotCaches.Create(SourceType:=xlDatabase, SourceData:=SourceData)

'Create pivot table from the pivot cache

Set pt = ptCache.CreatePivotTable(TableDestination:=StartPt, TableName:="PivotTable1")

End Sub


Delete all Pivot Tables in the Workbook

What Does this Macro Do?

This Macro will delete all the pivot tables in the workbook in one go. This code uses two loops. The first one loops through each worksheet in the active workbook. The second loop goes through each pivot table in each worksheet and deletes them.

Source VBA Code

Sub DeleteAllPivotTables()

'This code will delete all pivot tables in the workbook

Dim Sht As Worksheet

Dim pt As PivotTable

For Each Sht In ActiveWorkbook.Worksheets

For Each pt In Sht.PivotTables

pt.TableRange2.Clear

Next pt

Next Sht

End Sub


Delete a Specific Pivot Table

What Does this Macro Do?

This Macro will delete a specific pivot table in the active worksheet. You will have to modify the code slightly based on what the pivot table you want to delete is called in your worksheet. Just change the pivot table name in the line of code as indicated in the comment below.

Source VBA Code

Sub DeleteSpecificPivotTable()

'This code will delete a specific pivot table

ActiveSheet.PivotTables("PivotTable1").TableRange2.Clear 'Change "PivotTable1" to the name of the pivot table you want to delete


End Sub


Hide Subtotals in a Pivot Table

What Does this Macro Do?

This Macro will hide the subtotals in your pivot tables. You must select a cell in the pivot table first otherwise you will get a message box asking you to select a cell in the pivot table and then the Macro will stop.

Source VBA Code

Sub HideSubtotals()

'This code will hide all subtotals in the pivot table

Dim pt As PivotTable

Dim pf As PivotField

On Error Resume Next

Set pt = ActiveSheet.PivotTables(ActiveCell.PivotTable.Name)

If pt Is Nothing Then

MsgBox "Please place your cursor inside of a pivot table."

Exit Sub

End If

For Each pf In pt.PivotField
 s

pf.Subtotals(1) = True

pf.Subtotals(1) = False

Next pf

End Sub


Unhide Subtotals in a Pivot Table

What Does this Macro Do?

This Macro works in the same way as the previous one but this time it will unhide the subtotals in a pivot table. Again, you must select a cell in a pivot table first.

Source VBA Code

Sub UnHideSubtotals()

'This code will unhide all subtotals in the pivot table

Dim pt As PivotTable

Dim pf As PivotField

On Error Resume Next

Set pt = ActiveSheet.PivotTables(ActiveCell.PivotTable.Name)

If pt Is Nothing Then

MsgBox "Please place your cursor inside of a PivotTable."

Exit Sub

End If

For Each pf In pt.PivotFields

pf.Subtotals(1) = Fals
 e

pf.Subtotals(1) = True

Next pf

End Sub


Refresh all Pivot Tables in a Workbook

What Does this Macro Do?

This Macro will refresh all the pivot tables in the workbook in one go. This is extremely useful if you have many pivot tables in a workbook. The Macro contains a loop which goes through each pivot table and refreshes them one at a time.

Source VBA Code

Sub RefreshAllPivotTables()

'This code will refresh all pivot tables

Dim pt As PivotTable

For Each pt In ActiveSheet.PivotTables

pt.RefreshTable

Next pt

End Sub


Enable the GETPIVOTDATA Function

What Does this Macro Do?

This Macro will enable the GETPIVOTDATA function. You may be wondering what the GETPIVOTDATA function actually is. Well, it is a function that is designed to extract data from the pivot table. It is used to ensure that formulas will reference the desired cells even if the pivot table has changed format. If you want to write a formula outside a pivot table using a cell in a pivot table, the formula will use the GETPIVOTDATA function. You will see a formula similar to this: “=GETPIVOTDATA("Sales",$A$3,"Sales Person","Jim","Units",2)”. It will not use regular cell references such as this: “=A3*D3”.

Source VBA Code

Sub EnableGetPivotDataFunction()

'This code will enable the GETPIVOTDATA function

Application.GenerateGetPivotData = True

End Sub


Disable the GETPIVOTDATA Function

What Does this Macro Do?

This Macro works in the same way as the previous one which enables the GETPIVOTDATA function but this one disables the GETPIVOTDATA function. If you want to see normal cell references when calculating cells in a pivot table then use this Macro. If you want to enable or disable the GETPIVOTDATA function manually you would normally have to go to Excel options and check or uncheck the “Use GetPivotData functions for PivotTable references” checkbox. With this and the previous Macro you can create two buttons on your worksheet and create a toggle feature to enable or disable this function which is much quicker.

Source VBA Code

Sub DisableGetPivotDataFunction()

'This code will disable the GETPIVOTDATA function

Application.GenerateGetPivotData = False

End Sub


ADVANCED MACROS

This section contains some of the more advanced Macros. With these Macros you can perform more advanced tasks in your worksheets which are not possible using just the Excel ribbon.

Save a Selected Range as a PDF

What Does this Macro Do?

This Macro will allow you to save a specified range as a PDF. The Macro will open up an input box which will ask you to select a range. Once you have selected a range and pressed the ok button it will open it up in PDF. This is extremely useful if you have a report or dashboard in Excel and you want to send a PDF version of it to your work colleagues or customer. You may have a receipt in Excel format for expenses which you need to send to Accounts in PDF format. Using this Macro will very quickly convert any range to PDF.

Source VBA Code

Sub SaveRangeAsPDF()

'This code will save a specified range as a PDF

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

DataRange.ExportAsFixedFormat Type:=xlTypePDF, OpenAfterPublish:=Tru
 e

End Sub


Convert Range to an Image

What Does this Macro Do?

This Macro will convert a specified range into an image. You may want to do this so you can apply the Picture Tools special formatting to make your worksheets look nicer. This means you have greater flexibility on applying formatting to a worksheet. You may also want to convert a range to an image so you can attach the image to an email. When you run the Macro an input box will appear asking you to select the range you want to convert to a picture. Once you have selected the range and pressed the ok button it will convert the specified range into an image.

Source VBA Code

Sub ConvertRangeToImage()

'This code will convert a range to an image

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

DataRange.Copy

ActiveSheet.Pictures.Paste.Select

Application.CutCopyMode = False

End Sub


Use Text to Speech

What Does this Macro Do?

This Macro will make Excel speak out all the text in the selected cells cell by cell. When the Macro is run an input will appear asking you to select the range of cells you want Excel to say out loud. People may want to use this feature for data entry. It can help them know what they are entering is correct without having to continually look up at the screen which will save them time.

Source VBA Code

Sub TextToSpeech()

'This code will make Excel speak out all the text in the specified cells, cell by cell

Dim DataRange As Range

Set DataRange = Application.InputBox("Select a range", "Select Range", , , , , , 8)

DataRange.Speak

End Sub


Activate a Data Entry Form

What Does this Macro Do?

This Macro will open up the default Excel data entry form in the active worksheet. Using this data entry form is one of the best ways to enter data in your worksheet. People often use data entry forms to ensure their data is structured correctly. You need to ensure there are column headings already in your worksheet for this Macro to work.

Source VBA Code

Sub OpenDataEntryForm()

'This code will open up the default Excel data entry form

ActiveSheet.ShowDataForm

End Sub


Create a Table of Contents

What Does this Macro Do?

This Macro is very useful if you have a workbook that contains many worksheets. When you run the Macro, it will insert a new worksheet and call it “Table of Contents”. It will then list all the worksheet tab names from cell A1 and then hyperlink them for quick navigation.

Source VBA Code

Sub TableOfContents()

'This code will create a table of contents in your workbook for each worksheet tab and create hyperlinks to them

Dim i As Long

On Error Resume Next

Application.DisplayAlerts = False

Worksheets("Table of Content").Delete

Application.DisplayAlerts = True

On Error GoTo 0

ThisWorkbook.Sheets.Add Before:=ThisWorkbook.Worksheets(1)

ActiveSheet.Name = "Table of Content"

For i = 1 To Sheets.Coun
 t

With ActiveSheet

.Hyperlinks.Add Anchor:=ActiveSheet.Cells(i, 1), Address:="", SubAddress:="'" & Sheets(i).Name & "'!A1", ScreenTip:=Sheets(i).Name, TextToDisplay:=Sheets(i).Name

End With

Next i

End Sub


MORE BOOKS BY EXCEL MASTER CONSULTANT

If you enjoyed reading this book then please look out for more Excel books written by me. I have Excel books in two series which are Excel Bible for Beginners
 and Excel Formulas and Functions
 .

Excel Bible for Beginners Series

Below are more books in the Excel Bible for Beginners series
 .

Excel Bible for Beginners: The Essential Step by Step Guide to Learn Excel for Beginners

[image: ]


If you are an Excel novice and would like to know all the great tools and features Excel has to offer then Excel Bible for Beginners: The Essential Step by Step Guide to Learn Excel for Beginners
 will show you.

What you will learn in this book:


	What is Excel?

	What is Excel used for?

	How to open and save workbooks

	How to use the Quick Access Toolbar

	How to change font styles

	How to wrap and merge text

	How to format numbers

	How to apply borders

	How to apply cell styles

	How to use the Format Painter tool

	How to insert and delete worksheets tabs

	How to insert and delete columns and rows

	How to freeze rows and columns

	How to hide/unhide columns and rows

	How to copy, paste and cut

	How to use the Excel Find and Replace tool

	How to use the Excel Text to Speech function

	How to create charts and format them

	How to create formulas

	How to print



And much more!

You can buy this book from Amazon by clicking either of the links below:

Amazon US:


https://www.amazon.com/Excel-Bible-Beginners-Essential-Guide/dp/B088JS6YVS


Amazon UK:


https://www.amazon.co.uk/Excel-Bible-Beginners-Essential-Guide/dp/B088JS6YVS


Excel Bible for Beginners: Excel for Dummies Guide to the Best Excel Tools, Tips and Shortcuts you Must Know
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Excel Bible for Beginners: Excel for Dummies Guide to the Best Excel Tools, Tips and Shortcuts you Must Know
 includes all the best Excel shortcuts, tools and tips to save you time, increase productivity and help you become more efficient with your worksheets.

Some of the topics this book covers includes:


	How to hide specific text in a worksheet

	How to quickly insert multiple rows using shortcut keys

	How to quickly shift between lots of open Excel windows

	How to repeat your last actions using just one keystroke

	How to get quick access to your favourite command buttons

	How to use the Camera tool

	How to quickly remove duplicate entries using the Advanced Filter tool

	How to quickly split text in one cell into multiple columns

	How to quickly format dates from US to UK format and vice versa

	How to make Excel speak back at you

	How to automatically populate data

	How to change data from column format to row format and vice versa

	How to make your worksheets very hidden

	How to analyse large datasets using Pivot Tables

	How to create two-way lookups

	How to access hidden features that are not available in the ribbon

	How to use some Excel formulas and functions to manipulate data quickly

	And much more!



You can buy the book from Amazon by clicking either of the links below:

Amazon US:


https://www.amazon.com/Excel-Bible-Beginners-Dummies-Shortcuts/dp/B08NF32JY6


Amazon UK:


https://www.amazon.co.uk/Excel-Bible-Beginners-Dummies-Shortcuts/dp/B08NF32JY6


Excel Bible for Beginners: The Step by Step Guide to Create Pivot Tables to Perform Excel Data Analysis and Data Crunching
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If you are want to learn how to create pivot tables to easily analyse large data sets then Excel Bible for Beginners: The Step by Step Guide to Create Pivot Tables to Perform Excel Data Analysis and Data Crunching
 will teach you how.


Here are some of the topics you will learn from this Excel book
 :



	What is a pivot table?

	Why you should use pivot tables?

	How you should structure your data source before you create a pivot table?

	How to create a basic pivot table?

	How to format and customise a pivot table?

	How to apply number formatting to a pivot table?

	How to display grand totals and subtotals to a pivot table?

	How to sort, filter and group items in a pivot table?

	How to perform calculations?

	How to use slicers to filter a pivot table?

	How to create pivot charts?



After reading this Excel book you will be able to create pivot tables and use all the available tools and functions to perform Excel data analysis easily. You will be able to create various Excel pivot tables from just one data source which summarises the data in different ways. If you have never used pivot tables before then you will learn how easy it is to analyse large data sets without using formulas. You will be able to use pivot tables in Excel dashboards and create slicers to summarise and dissect information in your pivot tables.

You can buy the book from Amazon by clicking either of the links below:

Amazon US:


https://www.amazon.com/Excel-Bible-Beginners-Analysis-Crunching-ebook/dp/B08BJFRM28


Amazon UK:


https://www.amazon.co.uk/Excel-Bible-Beginners-Analysis-Crunching/dp/B08BF2V4R4



Excel Formulas and Function Series

Below are books in the Excel Formulas and Functions series
 .

Excel Formulas and Functions: The Complete Excel Guide for Beginners
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If you want to learn about the best and most commonly used Excel formulas and functions to use for your worksheets then you need to buy Excel Formulas and Functions: The Complete Excel Guide for Beginners


This book includes:


	Tips on how to create more efficient formulas

	How the order of operator precedence in Excel formulas work

	How to check formulas in your worksheets

	How to use the Excel Insert Function Formula Builder to make formulas easier to write

	How relative, absolute and mixed cell references are used to construct formulas

	How to create sum and counting formulas using Excel functions such as SUMIF, SUMIFS, COUNTIF, COUNTIFS, COUNTBLANK

	How to create logical formulas using the IF, OR, AND functions

	How to create lookup formulas using Excel functions such as VLOOKUP, HLOOKUP and combining the INDEX and MATCH functions together to create powerful one way and two-way lookups

	How to create text formulas by using Excel functions such as LEFT, RIGHT, MID, and CONCATENATE to manipulate text in your worksheets

	Great Excel hints and tips to help you become more efficient and save time



And much more!

You can buy the book from Amazon by clicking either of the links below:

Amazon US:


https://www.amazon.com/Excel-Formulas-Functions-Complete-Beginners/dp/1699170932


Amazon UK:


https://www.amazon.co.uk/Excel-Formulas-Functions-Complete-Beginners/dp/1699170932


Excel Formulas and Functions: The Step by Step Excel Guide on how to Create Powerful Formulas
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If you want to learn how to create powerful formulas such as array formulas that perform the impossible then you can buy Excel Formulas and Functions: The Step by Step Excel Guide on how to Create Powerful Formulas


In this book you will learn:


	How to create more advanced Excel formulas using powerful Excel functions such as SUMPRODUCT

	How to create array formulas

	The advantages and disadvantages of array formulas

	What arrays and array constants are

	What the order of operator precedence is and how Excel orders the calculation in formulas

	How to create formulas that do the impossible!



And much more!

Each example of how to create a formula starts off with a real-life business case scenario and will explain what Excel functions will be used in the formula to solve the business case scenario problem. It will also give you step by step instructions of how the formulas work by breaking each section of the formula down in simple easy to follow steps.

You can buy the book from Amazon by clicking either of the links below:

Amazon US:


https://www.amazon.com/Excel-Formulas-Functions-Create-Powerful-ebook/dp/B085ZQKXSV


Amazon UK:


https://www.amazon.co.uk/Excel-Formulas-Functions-Create-Powerful/dp/B0863S1948


Excel Formulas and Functions: The Step by Step Excel Book for Beginners on how to Master Lookup Formulas using the XLOOKUP Function
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Learn how to create powerful lookup formulas using the new Excel XLOOKUP function. Excel Formulas and Functions: The Step by Step Excel Book for Beginners on how to Master Lookup Formulas using the XLOOKUP Function
 is the most comprehensive book yet on XLOOKUP. Many workplaces require you to work with large data sets and to manipulate and extract information from the data set. XLOOKUP is the easiest and best way to do this and this book will teach you how with clear examples and lots of screenshots. You can also download free practice worksheets so you can follow along and practice what you have learnt.

In this book you will learn:


	What is XLOOKUP?

	What the XLOOKUP syntax is and an explanation of all its arguments

	What the limitations of VLOOKUP are and how XLOOKUP addresses these

	What are relative and absolute cell references

	How to perform vertical lookups using XLOOKUP

	How to perform horizontal lookups using XLOOKUP

	What the different error types are in Excel

	How to use XLOOKUP to replace errors with more meaningful values

	How to perform an approximate match using XLOOKUP

	How to use wildcard characters to perform partial matches with XLOOKUP

	How to extract the last value in a column or array using XLOOKUP

	Learn what the new ‘Spill’ term is and why it occurs

	How to return multiple values across cells using just one XLOOKUP formula to save time

	How to perform two-way lookups using XLOOKUP which replaces the more complex INDEX+MATCH functions



You can buy the book from Amazon by clicking either of the links below:

Amazon US:


https://www.amazon.com/Excel-Formulas-Functions-Beginners-Function-ebook/dp/B08F73L8V5


Amazon UK:


ABOUT THE AUTHOR
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Harjit Suman is an Excel and VBA consultant. He has over 10 years’ experience in Excel and VBA and has written a range of books, including Amazon best sellers, to pass on his knowledge of Excel to others. He has also provided Excel and VBA consultancy services to small and medium sized businesses. An Analyst in a large global organization, he also enjoys keeping fit, enjoys most sports and takes tennis lessons.

Harjit is also the founder and owner of the Excel Master Consultant website
 which offers information in everything about Excel. In his website you will find:


	Excel tutorials and blogs to expand your Excel knowledge

	Books you can buy that he has read while he was learning Excel which has helped him to 
 advance his Excel skills

	Excel applications you can buy which will make you more efficient and save you time

	Online Excel and VBA courses you can buy

	More information about his Excel consultancy services that he offers

	An online shop where you can buy books, Excel applications and courses



To check out his website just click the link below:


https://www.excelmasterconsultant.com/


Please take a visit and drop him a message. He would love to hear from you.
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